Delphi 2005’s Web Services

by Craig Murphy

Delphi 2005 allows us to create web services for .NET and for Win32. It also allows us to create web
service consumers using WinForms, VCL for .NET and Win32. This article explores each of those and
will give you a high-level overview of Delphi 2005’s web service capabilities.

Introduction

Web services are all around us. What is interesting about web services is the fact that they have been around
for a long time. For example, simply using a browser to look at a web page on a server could be construed
as running a web service. This is more evident if the web page is actually a VBScript or JavaScript ASP or a
PHP script, etc. More so if the client’s browser passes in query strings that instruct the script to do something
unique for that particular client.

However, as professional developers, we have probably steered away from scripting languages, favouring
the compiled approach or, more recently, the just-in-time (JIT) approach. We probably cited security and
performance as reasons not to adopt web service architectures.

Web Services in .NET

Delphi 2005, like Delphi 8, brings with it access to .NET’s underlying web service architecture. That
architecture makes building web service oriented applications almost as easy as it is to build a Windows
application using Win32/VCL controls: drag and drop. Indeed, one of the design goals for .NET was to
bring web development into the same easy-to-use environment that desktop had undergone with the
introduction of great IDEs like Delphi 1 and, to an extent, Visual Basic. That said, Visual Studio.net has
made building web service based applications remarkably easy: now Delphi 2005 offers us that power too!

If we wish to build and test web services locally, we must have a web server running. | will be using Internet
Information Services (11S), although you are free to choose your own.

The first step is to create a new Delphi for .NET project, an ASP.NET web service to be more precise. Figure
1 presents Delphi 2005’s New Items dialog.
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Figure 1: Creating a web service using Delphi 2005
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Figure 2: Naming the web service and choosing a web server

After clicking on OK, Delphi 2005 then goes off to create the .NET web service. In doing so it creates a
sample web method that demonstrates how to write methods that can be invoked using the web service.
This is really rather useful as the first hurdle we are likely to encounter is confirming that the web service
actually works. Listing 1 presents the source code for the sample web service: | used Delphi 2005’s Rename
refactoring to change the name of the web service and have stripped out some comments to preserve space.

unit wsGeeting;

interface

uses
System Col | ections, System Conponent Model ,
System Data, System Di agnostics, System Wb,
Syst em Web. Servi ces;

type
TWebServi ceGreeting = cl ass(System Web. Servi ces. WebSer vi ce)
{$REG ON ‘ Desi gner Managed Code’'}
strict private
/1l <summary>
/1l Required designer variable.
/1l </sunmary>
conponents: | Container;
/1l <summary>
/1l Required method for Designer support - do not nodify
/11 the contents of this method with the code editor.
/1l </sunmary>
procedure InitializeConponent;
{ $ENDREG ON}
strict protected
procedure Di spose(di sposi ng: bool ean); override;

private

{ Private Declarations }
public

constructor Create;

[ WebMet hod]

function HelloWwbrld: string;
end;

i mpl ement ati on

{$REG ON ‘ Desi gner Managed Code’}

/1l <summary>

/11 Required nmethod for Designer support - do not nodify
/11 the contents of this method with the code editor.
/1l </sunmary>

procedure TWebServiceGreeting.InitializeConponent;

begin

end;

{ $ENDREG ON}

constructor TWebServi ceGreeting. Create;
begin

i nherited,

InitializeConponent;
end;
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procedure TWebServi ceG eeting. Di spose(di sposi ng: bool ean);
begin
i f disposing and (conponents <> nil) then
conponent s. Di spose;
i nherited Di spose(disposing);
end;

functi on TWebServi ceG eeting. Hel l oWorl d: string;
begi n

Result := ‘Hello World';
end;

end.

Listing 1: Delphi 2005 creates a sample web service automatically

Invoking the web service is the simple matter of pointing your browser to: http://localhost/wsD2005/
wsGreeting.asmx at which point your Figure 3 should look familiar.
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Figure 3: Invoking our first Delphi 2005 web service

The ASP.NET run-time recognises that wsGreeting.asmx is a web service and presents us with the web
service’s list of operations, in this case a method called HelloWorld. Clicking on the Service Description link
leads us to the Web Service Description Language (WSDL) for this particular web service. Thankfully we do
not have to worry about the WSDL as Delphi and other ASP.NET tools take care of this for us.

Clicking on Hello World will present us with an opportunity to invoke the web service. Figure 4 presents
the screen that we should expect having clicked on Hello World.
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Figure 4: Preparing to invoke the wsGreeting web service

The routine that created Figure 4 is smart enough to know about the Hello World method. For instance, it
knows that it takes no parameters, hence it has offered us the Invoke button. If aweb service takes parameters,
these are specified in the WSDL document. Thus any process that is said to consume a web service can use
the WSDL to determine what parameters to pass into the web service.

In fact, it is the WSDL that helped create the SOAP request and response shown in Figure 4. In days gone by
we, as developers, had to create these responses manually: a tiresome and error-prone task.

Hello World is the simplest possible web service that we could write, but it is enough to convince us that the
process works from end-to-end? Clicking on Invoke reveals Figure 5.
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Figure 5: Hello World via a Delphi 2005 web service

Having seen how easy it is to create web services and test them via a browser window, how easy is it to
create an application that consumes (uses) the web service that we just created? Well, that is what we will
look at next. Delphi 2005 offers us two approaches to web service invocation: using WinForms or using the
VCL for .net.
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Consuming a Web Service using WinForms

First things first: we need to create a new Windows Forms Application. This can be achieved via the File>New
menu as shown in Figure 6.
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Figure 6: Creating a Delphi WinForms application

Once Delphi 2005 has created the WinForm application, we need to lay out the WinForm as shown in Figure 7.
We need a couple of Labels, two TextBoxes and a Button component.

Grasting

| Invoke web Service |

Figure 7: The WinForm Web Service Consumer User Interface

The next step is to add the web service that we wish to invoke to the current project. This can be achieved by
right-clicking on the Project Manager dock window then choosing Add Web Reference, as shown in Figure 8.
Alternatively, the Project>Add Web Reference menu option achieves the same.
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Figure 8: Adding the Web Service to the project
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Adding a web reference requires us to provide the URL of the web service that we wish to use. In this
instance, it is this URL: http://localhost/wsD2005/wsGreeting.asmx. Figure 9 presents a screenshot of

where we are so far.
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Figure 9: Specifying which web service we wish to add

At this point, your firewall might raise an alert! Clicking the Go [blue] arrow invokes disco.exe: this is a
.NET executable that is capable of discovering web services from their URL. Similarly, wsdl.exe should also
trigger your firewall as it goes off in search of the WSDL for this web service. Assuming that we allow

disco.exe and wsdl.exe to do their stuff, Figure 10 should look familiar.
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Figure 10: Adding a web reference confirms the operation is available
All that is required now is to click on Add Reference.
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Figure 11: The Project Manager after adding a web reference
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Now that we have added a reference to the web service, Delphi has created a new unit: localhost.wsGreeting.
It contains a proxy class that is used to invoke the web service(s). Creating a class proxy for the web service
means that we can enjoy all the benefits of design-time type checking: something would be sorely lacking if
we tried to invoke this web service using the raw SOAP request/response that we saw earlier.

I have included the contents of this unit in Listing 2 for the sake of completeness — | would not expect to make
any serious use of this unit other than for the name of the proxy class and the method(s) it surfaces.

unit | ocal host.wsG eeting;

interface

uses System Di agnosti cs,
System Xml . Seri al i zati on,
Syst em Web. Servi ces. Prot ocol s,
Syst em Conponent Model ,
System Web. Servi ces, System Web. Services. Description;

type
[ Syst em Di agnosti cs. Debugger St epThr oughAt tri but e]
[ Syst em Conponent Model . Desi gner Cat egoryAttri bute(‘ code’)]
[ Syst em Web. Servi ces. WebSer vi ceBi ndi ngAttri but e( Nane=" TWebServi ceG eetingS +
‘oap’, Nanespace="http://tenpuri.org/’)]
TWebServi ceGreeting = class(System Web. Servi ces. Protocol s. SoapHtt pd i ent Protocol)
public
constructor Create,
[ Syst em Web. Servi ces. Prot ocol s. SoapDocunent Met hodAttribute(‘ http://tempu’ +
‘ri.org/Hellowrld , RequestNanespace='http://tenpuri.org/’, ResponseNanespace="h' +
‘ttp://tenpuri.org/’, Use=System Web. Servi ces. Descri pti on. SoapBi ndi ngUse. Literal,
Par anet er St yl e=Syst em Web. Servi ces. Prot ocol s. SoapPar anet er Styl e. W apped) ]
function HelloWworld(strGreeting: string): string;
function BeginHell oWrld(strGeeting: string; callback: System AsyncCal | back;
asyncState: System Object): System | AsyncResult;
function EndHel | oWorl d(asyncResult: System | AsyncResult): string;
end;

i mpl ement ati on

{ $SAUTOBOX ON}
{$HI NTS OFF}
{ $WARNI NGS OFF}

constructor TWebServi ceG eeting. Create;

begi n

inherited Create,;

Self.Url := *http://]ocal host/wsD2005/ wsGr eeti ng. asnx’ ;
end;

function TWebServi ceGreeting. Hel |l oworl d(strGreeting: string): string;

type
TArrayOf System Cbj ect = array of System Object;
var
results: TArrayOf System Obj ect;
begi n
results := Self.lnvoke(‘Hellowrld , TArrayOf System Cbject.Create(strGeeting));
Result := (string(results[0]));
end;

function TWebServi ceG eeting. Begi nHel | oWorl d(strGreeting: string; call back:
System AsyncCal | back;

asyncState: System bject): System | AsyncResult;
type

TArrayOf System Cbject = array of System Object;
begin

Result : = Self.Beginlnvoke(‘HelloWrld , TArrayCf System Cbject. Create(strG eeting),

cal | back, asyncState);

end;

function TWebServi ceGreeting. EndHel | oWorl d(asyncResul t: System | AsyncResult): string;
type
TArrayOf System Cbj ect = array of System Object;
var
results: TArrayOf System Obj ect;
begi n
results := Sel f.Endl nvoke(asyncResult);
Result := (string(results[0]));
end;

end.

Listing 2: localhost.wsGreeting — the proxy class for our web service
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Once we have added localhost.wsGreeting to the uses clause, we are able to make use of the web service.

The code behind the button Invoke Web Service is surprisingly short. Listing 3 presents all the code that is
required to invoke the wsGreeting web service. Even using strResponse, the code is surprisingly short and
easy to understand.

procedure TW nFor nil. bt nl nvoke_d i ck(sender: System Object; e: System Event Args);

var nyWebService : TWebServi ceG eeting;
strResponse : string;
begin
myWebServi ce : = TWebServi ceG eeting. Create;

strResponse : = myWebService. Hel | oworl d( tbG eeting. Text );

t bResponse. Text := strResponse;

end;

Listing 3: Invoking the web service is really this easy!

Taking a further look at Listing 3, the line that is highlighted in bold does all the hard work for us. If you
have a firewall running, it is this line that actually instantiates a connection with the [remote] web service,
hence your firewall should attempt to block the connection. Obviously this presents us with a few design
issues and we may have to involve our network administrators in a discussion about which web services are
considered allowable.

Consuming a Web Service using the VCL

It is possible to consume the same web service using the VCL for .NET. The process is identical, except that
we create a VCL Forms Application instead of a WinForms Application. All the code is the same as that for
the WinForms consumer at which we have just looked.

Web Services in Win32

Building and consuming web services using Delphi 2005 in a Win32 environment is not very different from
doing the same using Delphi 6 or 7.

Win32 Server
File > New - Other - Delphi Projects > Web Services

& Hew lFems EI
T

C# Prajacs | [ 0
~ | Crestsl Reperts E ti % ﬂ
Desiphitoe MET Frojects | SOAF Sarver  B06F Serem |
rirmssmb | Dk Fecdi Irimrfacw Ermgronfur
Hes: MEa |
Desiphd Frodeats
25 L
Buerress
Db Filmi
[rirseeh
ol ol
T Wehrlaryvioes
Wakiaman
EFL
Ciher Fles
L Tigsk
— | Weh [onareniy

|:-|I-:nu||-|-h|

Figure 12: Creating a new SOAP Server Application

The Developers Group Magazine May/June 2005 Page 8 return to index


www.drbob42.net

Mew SOAP Server Application
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Figure 13: Selecting a cgi executable

Add New WebService X
Identifiers Code generation
Chabiti el ¥ Generate comments
Wiri32Gresting

[~ Generate sample methods
Unit identifier

Win32Greeting

Service activation model:

|Per Request ﬂ
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Figure 14: Specifying the web service name

{ Invokable interface | Wn32G eeting }

unit Wn32G eetinglntf;

interface

uses | nvokeRegistry, Types, XSBuiltlns;

type
{ Invokabl e interfaces nmust derive fromllnvokable }
| Wn32Greeting = interface(llnvokabl e)
[*{68885429- E463- 4F6E- 8918- FO6FF272056F} ' ]

{ Methods of Invokable interface nust not use the default }

{ calling convention; stdcall is reconmended }
function echoG eeting(const strGreeting: String): String; stdcall;
end;

i mpl ement ati on

initialization
{ Invokabl e interfaces nmust be registered }
InvRegi stry. Regi sterlnterface(Typel nfo(l Wn32G eeting));

end.

Listing 4: The Win32 web service interface
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{ Invokabl e inplenmentation File for TWn32G eeting which inplements | Wn32G eeting }

unit Wn32G eetingl npl;
interface

uses | nvokeRegistry, Types, XSBuiltlns, Wn32G eetinglntf;

type

{ TWn32G eeting }
TW n32Greeting = cl ass(TlInvokabl eCl ass, | Wn32G eeti ng)
public
function echoGeeting(const strGreeting: String): String; stdcall;
end;

i mpl ement ati on
{ TWn32G eeting }

function TWn32G eeting. echoG eeting(const strGreeting: String): String;
begin

Result := ‘Hello, * + strGeeting;
end;

initialization
{ Invokabl e cl asses nust be registered }
I nvRegi stry. Regi st erl nvokabl eCl ass( TW n32Greeti ng) ;

end.

Listing 5: The Win32 web service implementation

Compiling the Win32 project that includes Listing 4 and Listing 5 will create an exe that can be used to
provide not just the web service implementation/method, but the WSDL too. But first we have to copy the
exe into our web server’s cgi scripting area: | have chosen to copy it to a directory called D2005_W32.

The first thing we should do is test that we can see the WSDL. This can be achieved by going to the following
URL: http://localhost/D2005_W32/W32GREETING.EXE/wsdl (assuming that the exe is called
W32GREETING!) If all goes to plan, Figure 15 should look familiar:
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Figure 15: It works. Win32 WSDL is available

Now that we know how to build the server-side web service, it is time to look at creating a client that
consumes it.
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Win32 Client

The Win32 client will be nothing more than a regular VCL Forms Application: File - New - Other, as
depicted by Figure 16.
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Figure 16: Creating a VCL Forms Application

The next thing we need to do is import the WSDL that the server-side web service produces. If you recall
Figure 15, there was a [WSDL] link beside the IWin32Greeting PortType — this link produces WSDL that
describes the web service.

Importing the WSDL makes use of the WSDL Importer: File > New > Other - Delphi Projects > Web
Services.
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Figure 17: Importing WSDL is easy using the WSDL Importer
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Figure 18: Specifying the WSDL that we wish to import
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Figure 19: Importing the WSDL reveals the web service interfaces

The WSDL importer will then create a new unit, in this case IWin32Greetingl. It contains an interface
representing the web service:

I Wn32G eeting = interface(llnvokable)

[*{888C8498- 104E- 967D- E3DE- DOC3F5A09BD0} ' ]
function echoGreeting(const strGeeting: WdeString): WdeString; stdcall;

end,
Now, if we drop a couple of TLabel components, a TButton, a couple of TEdit components and a THTTPRIO
component onto the main form we can then test the web service. The arrangement of the components should

be similar to the WinForms example we saw earlier. The code behind the button click should look like
Listing 6.

procedure TForml. bt nl nvokeC i ck( Sender: TQbject);
var nyWebService : | Wn32G eeting;

begin
myWebService := HITPRI O as | Wn32G eeti ng;

edt Response. Text := myWebService. echoG eeting( edtG eeting. Text );

end;

Listing 6: Invoking the Win32 web service using a Win32 client applications

The Developers Group Magazine May/June 2005 Page 12 return to index


ww.tdmweb.com
www.drbob42.net

Now, if we invoke the web service using the text “DELPHI 2005 ROCKS!” Figure 20 should look gratifyingly
familiar:

r_ Wind7? Weh S=rvice Commume;

Greeting

DELPHI 2005 ROCKS!
| Invoke Web Service |

Response
[Hella, DELPHI 2005 ROCKS!

Figure 20: Putting it all together

Summary

This article has provided a high-level overview of Delphi 2005’s web service capabilities. A future article
will look at building a more functional and more practical web service based application.

Web services should be platform and language-agnostic. In other words, we really should not care what
language a web service is written in, nor should we care about which language is consuming a web service.
In reality there are some interoperability issues, so it is still worth proceeding into the web services
arena with care.

‘!_' Craig is an author, developer, speaker, project manager, Certified ScrumMaster and
Microsoft Most Valuable Professional (XML Web Services). He specialises in all things
XML, particularly SOAP and XSLT. Craig is evangelical about .NET, C#, Test-Driven
Development, Extreme Programming, agile methods and Scrum. He can be reached via
e-mail at: bug@craigmurphy.com, or via his web site: http://www.craigmurphy.com
(where you can also find the source code and PowerPoint files for all of Craig’s articles,
reviews and presentations).
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